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©1982-2020 Spring Manufacturers Institute, Inc. 
and Universal Technical Systems, Inc. All rights reserved. 

Rights to certain elements included in this product 
are owned separately by The Spring Manufacturers Institute, Inc., 

and Universal Technical Systems, Inc. 
 

Customer License Agreement for Advanced Spring Design Software 
From Spring Manufacturers Institute (SMI) and 

Universal Technical Systems, Inc. (UTS) 
 
READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY BEFORE USING THIS SOFTWARE. YOUR OPENING OF THIS 
PACKAGE WILL INDICATE YOUR ACCEPTANCE OF AND AGREEMENT TO THESE TERMS AND CONDITIONS. IF YOU DO NOT 
AGREE TO THESE TERMS AND CONDITIONS, DO NOT OPEN THIS PACKAGE, AND PROMPTLY RETURN THE UNOPENED 
PACKAGE TO YOUR PLACE OF PURCHASE. 
 
1. Computer System Type. IBM PC and compatible computers operating under Microsoft Windows XP, Vista and Windows 
7 operating systems. 
 

2. Permitted Use. You are granted non-exclusive, non-transferable license to use the SOFTWARE on only one (1) computer 
system during the term of the license, unless you have been given an express written license to use the SOFTWARE on 
multi-computer network. You may make such limited number of copies of the SOFTWARE as are necessary for backup 
purposes. You may not modify the program or merge it into another program. Expect as specified herein, you may not 
otherwise copy, modify, network, sell, transfer, sublicense, publish or otherwise distribute the SOFTWARE. 
 
3. Copyright. The SOFTWARE and its documentation are copyrighted. 
 
4. Limited Warranty. To you, the original licensee, only, UTS and SMI warrant the distribution media on which the 
SOFTWARE is recorded to be free of defects in material and workmanship under normal use for a period of ninety (90) days 
from the date of delivery of license authorization. UTS and SMI hereby expressly exclude the implied warranties of 
merchantability and fitness for a particular purpose. Your sole and exclusive remedy in the event of a defect in material or 
workmanship under normal use is expressly limited to the replacement of the original distribution media. If UTS cannot 
deliver a copy of the program on media free of defects or errors, you may terminate this license by returning the program 
to UTS. In no event will UTS's or SMI's liability exceed the price paid to UTS or SMI product. 
 
5. Disclaimer. Neither UTS nor SMI warrants that the SOFTWARE will satisfy your or any other end-users' 

requirements; nor do they warrant that the operation of the SOFTWARE will be uninterrupted or error-free or 
that defects in the SOFTWARE can be corrected. Neither UTS nor SMI makes any warranty as to results to be 
obtained from use of the SOFTWARE. You understand that other than the foregoing warranty regarding the 
distribution media, the SOFTWARE is being distributed on an "as is" basis, without oral or written warranties of 
any kind, whether Statutory, Express or Implied. You understand and agree that UTS and SMI have excluded 
the implied warranties or merchantability and fitness for a particular purpose or use. Neither UTS nor SMI shall 
be liable for any indirect, incidental, special or consequential damages arising out of use of the SOFTWARE or 
out of any breach of any warranty. 
 
6. Term. This license is effective for a period as stated in your purchase contract. You may terminate it at any time by 
destroying the program and all copies thereof, in whatever form. The license will also terminate if you fail to comply with 
any of the terms or conditions of the license, and you agree to destroy the program and all copies thereof, in whatever 
form, upon any such termination. There will be no refunds upon termination. 
 
7. Limitation of Liability. YOU AGREE THAT UNDER NO CIRCUMSTANCES AND IN NO EVENT WILL SMI OR UTS BE LIABLE 
TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY DAMAGES, INCLUDING ACTUAL, DIRECT, INDIRECT, SPECIAL, 

INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND INCLUDING, BUT NOT LIMITED TO, LOST PROFITS OR LOSS OF USE OF 
THE PROGRAM OR ANY EQUIPMENT ON WHICH IT MAY BE INSTALLED, EVEN IF SMI OR UTS HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, REGARDLESS OF THE FORM OF ACTION IN WHICH ANY SUCH DAMAGES MAY BE 
CLAIMED. 
 
8. Miscellaneous. This license shall be governed by the laws of the State of Illinois. This license is the complete and 
exclusive statement of the agreement of the parties with respect to the subject matter hereof. 
 
9. Several Provisions. If one or more of the provisions in this license are found to be void or unenforceable by a court of 
competent jurisdiction, such provisions shall be deemed to be stricken herefrom, and the remainder of the license shall be 
enforceable as if such provisions had not been included herein. 
 
10. System Clock. Rare circumstances may lead the license checking program used by UTS to return the message “System 
clock has been set back”. This may happen when the system clock has been reset even if the time and date are accurate. 
 
UTS has created a software utility that corrects the system clock error in most cases. UTS will furnish this utility but does 
not bear any responsibility if the problem persists. We do not promise to solve the issue but we do promise to try to help 

correct it. Contact UTS if you would like assistance with this error message. The responsibility for restoring the functioning 
of the date-dependent license rests entirely on the customer. 
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Introduction 

Advanced Spring Design Version 7 (ASD7) is a joint effort of the Spring Manufacturers 

Institute, Inc. (SMI) and Universal Technical Systems Inc. (UTS). ASD7 is the successor 

product of ASD6, GSDS 5.x and The Spring Designer 2.1, the previous versions of spring 

design software developed and marketed by SMI. ASD7 is based on extensive input of 

the SMI Technical Committee and follows the design conventions of the SMI Handbook 

of Spring Design and the SMI Encyclopedia of Spring Design. ASD7 also benefits from 

the feedback and suggestions of many users of ASD6 and we greatly value the 

relationships we continue to build with SMI and ASD users. 
 

ASD7 also reflects the engineering and software expertise of UTS, developer of TK 

Solver and a number of other popular engineering applications. 

 

If you have used GSDS, you will find that many functionalities have been consolidated 

and simplified. The explanations below will make the transition easy for you. 

 

If you are a new user, you will find the flexible sequence of operations clear and 

logical. Just input what you know and ASD will tell you what it can. 

 

What’s New in ASD7.14 

Rocket-Missile Wire has been added to the list of available materials. Two entries 

were added; one for wire sizes less than 0.08 inches and another for wire sizes from 
0.08 to 0.12 inches. This is because of a significant discontinuity in the tensile 

strength data. The data was provided by Mapes Wire Corporation and was originally 

developed by National Standard. 

 

Two new entries for Chrome Silicon have been added to the list of available materials. 

Class B is also known as Chrome Silicon Vanadium. Class C&D is also known as Chrome 

Silicon Molybdenum. Tensile strength data for both comes from ASTM A877. 

 

The Minimum Tensile Strength (MTS) material property data for Chrome Silicon Valve 
wire has been updated based on ASTM A877. The resulting MTS values will be higher. 

This will also impact fatigue life calculations, resulting in increased estimates. 

The Max Diameter value changed from 0.625 to 0.375 and extrapolation for larger wire 

should NOT be done. 

 

A new DXF image control is now used in the Show DXF window and in the reports. The 

old control was conflicting with some display configurations. 

 

Improved formatting of the email addresses on reports. 

 
Left-hand wound extension spring 3D images were not displayed properly. This has 

been fixed. 
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CalcEdge Apps 

We will be using CalcEdge to share preliminary versions of spring design calculations 

before they are considered for additions to the Advanced Spring Design program (ASD). 

This will help us in testing and gathering feedback. See the CalcEdge Apps section of the 

help for more information 

 

Torsion Springs 

 Improved formatting of the reports keeps the DXF image and design notes on 

page 1. 

 Input of arm angle or angle between arms is now permitted and impacts the 
design if the optional allowable body length value has been input. 

 Double torsion springs can now be pitched and not just close wound. 

 

Extension Springs 

 3D image rendering has been improved. Hooks are centered more accurately, 

for example. 

 Swivel hook wire diameter is now saved with the design. 

 Tapered dead coils are now properly accounted for in the rate calculation. 

 Rectangular wire weight calculation is more accurate. 
 “Full Loop” has been added as an end type. This is the same as selecting 

“Machine” with an input of 0 for the hook gap value. 

 Two different end types can now be specified. 

 

Washer Springs 

 The reports have been corrected and correctly formatted. 

 

Materials 

 Hastelloy C276 has been added to list of materials in the “Round” category 

and is available for use in helical spring designs. 
 The APB value for Stainless 17-7 has been changed from 60% to 75%. 

 (Pending) Users can now control the sequence in which materials are 

displayed in the forms. So if you add a new material, it no longer has to 

remain at the bottom of the list. 

 A bug was fixed which caused the program to crash if you tried to save more 

than one material at a time. 

 

Spiral Torsion Springs 

 The 3D image is now rendered more accurately. 
 The labels and formatting on the form are improved. 

 The program now solves for the strip thickness if the torque to set is specified. 

 

Two Conical Springs in Series 

 For the case of one end small and the other large, the 3D image is now 

rendered more accurately. 

 

Tolerance Grade Default Setting 

 The default for new designs has been changed from Commercial to Precision. 

This results in smaller default tolerances. 
 

Series Compression Springs 

Variable TPavg has been added to set the transition pitches equal to the average of the 

surrounding pitches. A check box in the forms allow users to activate this. 
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Design Notes 

 A quirk in the programming prevented users from using the Enter key to add 

lines to notes when saving designs. This has been fixed. 

 

3D Coordinates Export 

 A new option is available in the Tools menu – 3D Coordinates Export. Users 

can now export the coordinates to a CSV formatted file. Such files can be 

imported into other programs such as spreadsheets or solids modeling 

software. So, for example, the data used in the ZX, ZY, and XY centerline 

plots in the extension spring programs is now available for export and use in 
other software. 

 

Tolerance Grade Default Setting 

The user is now able to set the default for Tolerance Grade to either Commercial or 

Precision. 

 

 
 

Fix for Scaling problems 

Microsoft has introduced a setting to fix scaling problems for users with high DPI 

settings. This fix will allow the user to continue to use high DPI settings without causing 

ASD forms to be cut off. 
 

To activate this setting: 

1. Locate the ASD7.exe file on your local hard drive. Typically this is found in the 

folder "C:\Program Files (x86)\UTS\Advanced Spring Design 7 \" 

2. Right-click on ASD7.exe and select "Properties" 

3. Click the "Compatibility" tab 
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4. Click the "Change high DPI settings" button 

 
5. A) Check the box "Use this setting to fix scaling problems for this program 

instead of the one in Settings" 

B) Check the box "Override high DPI scaling behavior. Scaling performed by: 

C) Select "System (Enhanced)" from the dropdown box 

 
6. Click "OK" 

7. Click "OK" 
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What’s New in ASD7.13 

Calculator icon 

 A calculator icon has been added to the toolbar. Click the icon to launch your 

computer’s calculator program. Numbers can be copied from the calculator (right click 

and select “Copy”) and pasted in any form field (right click and select “Paste”). 

 

Form Fields Copy and Paste 
All form fields can now be copied from and pasted into. To copy, right click and select 

“Copy”. To paste, right click and select “Paste”. 

 

Copy and Save Plots 
Plots can now be copied or saved from ASD7. Right click on the plot and choose “Copy” 

to place the plot in your clipboard where it will be available to paste into another 

program. Right click on the plot and choose “Save” to save the plot in picture format. 

 
 

Copy and Save 3D Images 
3D images can now be copied or saved from ASD7. Click the “Copy” button to place the 

3D image in your clipboard where it will be available to paste into another program. 

Click the “Save” button to save the 3D image in picture format. 
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Plot DPI in Reports 
A DPI setting has been added to the Standard Report Configuration form. The DPI field 

determines the resolution of the plots in the report. DPI must be between 96 and 200. 

DPI of 96 makes the details of the plot larger whereas DPI of 200 makes the details 

smaller. 

 

Round Wire Extension Springs 
The program will generate accurate plots of 3D centerline coordinates. A check box has 

been added to the form, defaulting to on. It should only be unchecked if a spring has too 

many coils to plot. Three new plots are now available, displaying the centerline 

coordinates in each of three planes – ZY, XY, and ZX. The ZY plot is automatically 

included at the bottom of page 1 of the report, replacing the DXF image. The DXF image 

is no longer supported for extension springs. 
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Here is the corresponding X-Y plot for this spring: 

-.6 -.4 -.2 0 .2 .4 .6

-.6

-.4

-.2

0

.2

.4

.6

X-Y Centerl ine Plot

 

Springs can now be specified with a hook on only one end. 

 
Hook geometry variables now includes angle and gap dimensions. The angle dimension 

is the angle from the load point to the tip/end of the wire. A 90 degree angle is assumed 

unless specified. 

 

Round Wire Conical Extension Springs 
This model exists in the current version but has been enhanced with the same features 

as the cylindrical round wire extension spring model. That is, it can have only one hook 

and new variables were added for the gap sizes and loop angles. The same plots were 
added as well. 

 

Rectangular Wire Extension Springs 
A new form (and report) is available for this new program. It is the same as the round 

wire version, except that instead of a single wire diameter variable, this progam has 

radial and axial wire thicknesses. 
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Rectangular Wire Double Torsion Springs 
A new model is included. It is very similar to the round wire version, replacing wire 

diameter with axial and radial wire thicknesses. 

 

Two Round Wire Compression Springs in Series (both cylindrical and conical 
programs) 
A check box has been added to the forms to force the pitches to be equal for all sections 

of the spring. The default condition is unchecked, allowing the pitches to be different. 

This will be useful for designs having variable diameters and a given/desired free length. 

 

Belleville Washers 
A new check box labeled “Flat Bearing Surface” has been added with the default 

condition being unchecked. The length of the flat bearing surface can optionally be 

specified. 

 

The diagram has been removed from the form to make room for a second set of load 

data. The plot is still available as a menu selection and/or on the report. The second set 

of load data permits the calculation of estimated cycle life, assuming the spring will cycle 

between the two load points. 

 

Spiral Torsion Springs 
Two new variables – Turns to Solid and Torque at Solid – have been added to the 

program. 

 

Various Spring Forms 
For ALL spring types, the labels “Minimum Cycle Load” and “Maximum Cycle Load” have 

been replaced with “Cycle Load 1” and “Cycle Load 2”. 

 

All Multiple-Tab Spring Forms 
There were some issues with the multi-tabbed forms not getting updated when a 

checkbox was checked or unchecked. We believe this problem has been corrected. 

 

Extension Springs 
Added Swivel Hooks as new end type option. These can have different wire size and 

material from the body coils. 

 

Parallel Compression Springs 
Changed the scaling for the envelope diagram from isotropic to linear. 

 

Synchronization of Forms Fixed 
Some of the check boxes on the forms were not causing the designs to recalculate 

automatically. 

 

Truncation of Notes Fixed 
Notes and descriptions were getting truncated by the database during storage. 

 

User-Defined SN Data Saved 
This is now saved with designs in the database. 

 

Hot Coiled Springs Torsion Modulus 
The torsion modulus now accurately defaults to 11500000 psi and the program includes 

a correction factor for the spring rate. Prior versions a had reduced value for the torsion 

modulus in addition to the correction factor which had the effect of doubling up on the 

correction. 
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External Snap Rings 
The forms displayed the tolerance signs incorrectly. 

 

Material Properties 
The MTS coefficients are updated for ASTM A679. 

Material property data is now available for ASTM A227 Class II 

If equation type Constant is selected, parameters P1 to P4 are correctly displayed as 0. 

 

Spiral Torsion Springs 
Equation PS-21 is no longer included as a default constraint but the forms adds an 

option to include it if so desired. 

 

Double Torsion Springs 
Wire length was incorrectly calculated based on active coils per side but is updated to be 

a function of body coils per side. 

 

Enhanced Math Models 
Significant effort has gone into both enhancing the existing math models and adding a 

number of new ones. Here is a summary of the results of that effort. 

 

Adding Users 
Users can now be assigned different privileges. Click on the Tools menu and select 

"Users". 

 

 

Checkbox: ........................ When checked means: 

Active ................................ The user is able to log in and use the software. 

Administrator ..................... This user can add users, change users, and change 

company information. This user can delete and archive any 

user's designs. 

Add Corp Profile .................. This user is allowed to add corporate profiles. 
Full Access (Designs) ........... This user can open and edit designs created by any other 

user. This user cannot delete or archive another user's 

designs. 

Add User ............................ This user is able to add new users. 

Add Customer ..................... This user is able to add customers. 

Add Project ........................ This user is able to add a project. 

ReadOnly Access (Designs) .. Designs created by another user will open as read-only. 

Read-only designs can be viewed and reports can be 

generated but they cannot be edited, saved, deleted or 
archived. This user may create, edit, save, delete and 

archive his or her own designs. 
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Blocking Designs 
A user may block other users from opening a design he or she created. In the "Open 

Design/Part Number" dialogue box, select a design and click the "Block User" button. 

Select the users to be blocked. 

 

Archiving Items 
A design may be archived. In the "Open Design/Part Number" dialogue box, select a 

design and click the "Archive" button. 

 

An archived design cannot be changed, saved or deleted. Reports can be generated. 

 

Exporting Designs 
Designs can be exported as text files or XML files for processing by external programs. 
 

3D images 

 

ASD7 provides 3 dimensional images of all spring designs. The image can be 

rotated and resized. Left-click, hold, and drag to rotate the image. Left-click 

on a corner or edge of the window to resize the image. 

 

Automatic Updates 
ASD7 automatically checks for updates each time the program is opened. If updates are 

available, the following dialog box will appear. 

 

Clicking the “Update Now!” button will download and install the files necessary to bring 
your ASD7 software to the current version. You can choose not to update by clicking 

“Don’t Update”. If you choose not to update, the update dialog box will appear again the 

next time you open ASD7. 
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Round Wire Conical Compression Springs 
Nonlinear spring rate formulas have now been included. The updated model runs fast 

and is fully backsolvable. Here is a sample plot. 

 
 

Round Wire Cylindrical Compression Springs 
An option has been added to adjust the number of inactive coils for closed end springs 

with relatively few coils. In the extreme case, this increases the number of active coils 

by 0.44. Note that it is still possible to use the dead coils variable to manually influence 

the number of active coils. Dead coils can be input as a positive or negative value. 

 

Minimum Weight Design Scenario - Round Wire Cylindrical Compression Springs 
ASD includes a check box for specifying a minimum weight design. This scenario assigns 

several default values and requires just four inputs. The stress at solid defaults to the 
maximum allowable fraction of the minimum tensile strength. The stresses at the cycle 

loads default to the 10,000,000 cycle condition. Inputs are required for the free length 

(or solid length), minimum cycle load, maximum cycle load, and the length (or 

deflection) at that load. 

 

Typically, it is best to select the Minimum Weight Design option prior to making other 

inputs. If you start from an existing spring design and then click the Minimum Weight 

Design option, you will likely get an Inconsistent message in the Design Status window 

and you will need to remove some existing inputs. 
 

Hot Coiled Compression Springs 
A model has been added which accounts for the different materials and processes that 

are used. For example, the spring can be designed using a bar with tapered ends. 

Different tolerance calculations can also be done. The model is based on the formulas 

from both the SMI Handbook and the Tolerance booklet. 

 

Round Wire Torsion Springs 
Arm length no longer defaults to 0 and can now be computed from other inputs such as 

force at arm. 

 

Rectangular Wire Torsion Springs 
Rectangular wire torsion springs now include the effects of keystoning on the body 

length and a bug in the body length calculations was fixed. 

 

Round Torsion Bars 
Hollow bars are now possible. 
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Curve-fitting program to find the minimum tensile strength parameters P0 – P4 
Many ASD users like to add materials to the existing database; however, they have 

difficulty determining how to compute the minimum tensile strength parameters. The 

new model allows users to enter experimental data (wire size and minimum tensile 

strength) into a table and get the parameters as outputs. Here is a sample plot from this 

program. 

 

 

Belleville Washers 
The model now does calculations involving stacks of washers in series and parallel. A 

plot has been added to illustrate the configuration. 

 

 

Power Springs 
Optional constraints have been added to the model to account for the so-called 50% 

space rule and other suggested ratios. 

 

Constant Force Springs 
Two models were created based on the formulas in the SMI handbook. The models 

handle extension and motor type springs. 

 

Snap Rings 
Six new math models are available for snap rings of different shapes and wire types. 

“C” shape – rectangular wire, internal or external 

“C” shape – round wire, internal or external 

“C” shape – round wire, external, installed via the gap 

“C” shape – rectangular wire, external, installed via the gap 

 

Round Wire Garter Springs 
Two models were added to handle compression and extension garter springs. These 
models include formulas for radial loads and deflections. 
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Nested Compression Springs 
By nesting two or more compression springs in parallel, a designer can achieve a 

variable rate over different ranges of loads and deflections. A mixture of cylindrical and 

conical springs is allowed, as is a mixture of round and rectangular wire springs. Here is 

a summary of the possible designs and a sample plot of the stresses in a 3-spring nest. 

Two nested cylindrical round wire springs 

Two nested cylindrical rectangular wire springs 

Three nested cylindrical round wire springs 
Three nested cylindrical rectangular wire springs 

Two nested cylindrical springs – rectangular wire on one, round on the other 

 

 

Compression Springs in Series 
By combining two or more compression springs in series, either stacked with spacers or 

continuously coiled, a designer can achieve a variable rate over different ranges of loads 
and deflections within space constraints. A mixture of cylindrical and conical springs is 

allowed. Here is a summary of the new models available in this area. 

Two cylindrical round wire springs in series, continuous 

Two cylindrical round wire springs in series, with spacer 

Three cylindrical round wire springs in series, with spacers 

Three cylindrical round wire springs in series, continuous 

Two cylindrical rectangular wire springs in series, continuous 

Two cylindrical rectangular wire springs in series, with spacer 

Three cylindrical rectangular wire springs in series, with spacers 
Two round wire conical springs in series, continuous 

Two rectangular wire conical springs in series, continuous 

 

The continuous coil models allow for transition coils between the two springs so in effect, 

a model listed as handling three springs in series actually deals with five. The last one is 

particularly interesting in that it allows for “barrel” or “hourglass” designs and takes into 

account the nonlinear rate and telescoping possibilities of conical springs. 
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All the new variable rate compression spring models include life estimates. These models 

allow users to include extra load points in addition to the life cycle load points. 

 

What ASD7 Will Do for You 

ASD7 represents a broad range of capabilities and benefits: 

 

ASD7 now includes an expanding number of spring types, doubling the number from the 

previous version. 

 

The SMI Encyclopedia of Spring Design is now included as part of the ASD7 Help 

System. Hundreds of pages of text, tables and diagrams are available and searchable, 

including direct, context-sensitive links from the related ASD7 forms. 
 

Messages and status information guide you throughout the design process. A broad base 

of SMI’s accumulated design knowledge has been built into ASD7. It appears as 

cautionary messages and warnings in the Design Status Window. 

 

A number of plots are available to pick from a drop-down list. You can keep one or more 

plots open during a design session and they automatically update as you make design 

changes. 

 
You can pick from standard report formats or you can customize a format to include only 

the parameters and plots you want. You can add your company’s name and logo, and 

you can save your customized reports as “templates” to use again. Reports can also be 

exported to RTF and PDF file formats for further editing in word processing software. 

 

Spring drawings in DXF format are automatically included in reports. You can also export 

drawings in DXF format for subsequent import into a CAD system. 

 

TK Solver drives ASD7 with unique calculation and optimization power. TK Solver gives 

ASD7 the power to “backsolve” giving you maximum design flexibility. 

System Requirements 

ASD7 operates on Windows XP, Vista, and Windows 7. ASD7 requires 512 MB of RAM. 

The application is optimized to run at a 1024x768 screen resolution. Higher resolutions 
will improve the usability, particularly when viewing plots during the design process. 
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Overview 

Menu System 

Menu Submenu Action 

File   

 New Design Starts a new design. 

 Open Design Opens a previously saved design. 

 Save Saves the current design to the existing location in the 

database. 
If the design is new this shows the Save As form. 

 Save As Saves the current design as a new database entry. 

 Profiles Opens a form for listing profiles and for adding and 

editing existing profiles. 

 Save As Profile Saves the current design as a profile in the database. 

 Exit Exits the program. 

View   

 Toolbar Shows/hides the toolbar.  

 Status Bar  Shows/hides the status bar. 

Tools   

 Solve Solves the current design model (when Instant Solve is 

switched off). 

 Show DXF Shows the DXF drawing for the current design. 

 Show 3D Shows the 3D image for the current design. 

 Export DXF Exports the drawing in DXF format 

 Standard 

Report 

Opens a form for generating a report. 

 Materials Displays the material details form for adding and editing 

material data. 

 Users Opens form for entering user information. 

 Customers Opens forms for listing and archiving information on 

customers. 

 Projects Opens forms for listing and archiving information on 

projects. 

 Company 

Information 

Opens a form for listing and editing the user’s company 

information. 

 Change My 

Password 

Opens a dialogue box to change the user’s password. 

 Import Data 

from ASD6 

Imports data from a design saved in ASD6. 

 Options Allows the user to choose default units and tolerance 

grade. 

Help   

 Contents Shows the application’s Help file, Contents tab. 

 Index Shows the application’s Help file Index tab. 

 Search Shows the application’s Help file Search tab. 

 About… Shows copyright and version information. 

 Check for 

Updates… 

Accesses the internet to check if software updates are 

available. 
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Toolbar 

 

(Left-hand portion) 

 

 
Starts a new design. 

 
Shows DXF drawing of the 
current design model. 

 
Opens a previously saved 

design.  
Shows the 3D image for the 

current design. 

 
Saves the current design using 

the same filename.  
Opens the Notes form. 

 
Solves the current design 

model.  
Generates Standard Report. 

 
Converts an output value to an 

input value.  
Shows the application’s Help 

file. 

 
Opens the Data Entry form. 

 
Exits the ASD7 application. 

 

 

(Right-hand portion) 

 

 
 

When checked, outputs are solved after each input. 

 

 
 

Increments or decrements the value of selected 

variable. 

 

 
 

Launches the calculator. 

 
 

Drop-down list of available plots. 

 

 
 

Changes the unit system used in the current design. 
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Definitions 

Backsolve—The ability to solve a mathematical model backward as well as forward; the 

ability to solve with any combination of inputs and outputs. 
 

Category—A particular spring design type—for example, compression or torsion. 
 

Default value—An input value supplied by ASD7 directly or by a profile. A user can 

override any default. 
 

Design—A design session or design project. Also, a particular, unique spring design 

created in such a session or project. 
 

Inconsistent—Having two or more contradictory input values, so as to be incapable of 

being solved. 
 

Input value—Data, supplied by the user or default that is used as a starting point for 

calculation. 
 

Model—A mathematical simulation. 
 

Optimized design—A design that satisfies the defined criteria or requirements. 
 

Output value—Results of a calculation. 
 

Profile—A group of default settings to be used within a particular spring design 

category. In ASD7, individual profiles can be grouped by type. 
 

Solved—Reaching a solution that is without error or interruption. 
 

Unique design—A design that is singular in every particular and, therefore, cannot be 

changed in any particular without changing the design. 

Passwords 

ASD7 allows for designs to be saved and grouped by user. That is, different users can 

store designs to the same database and those designs can be searched later with user 

as the criteria. Each user has their own login name and password. Initially, the default 

login name is “admin” and the password is “admin”. The admin user is permitted to view 
all other users’ designs. The password can be edited using the ASD7 Tools menu and 

clicking Users. This is also where additional users can be added, each with their own 

login and password. 

Using ASD7 

In ASD7, any of the design variables may be used as inputs or outputs, creating the 

“backsolving” capability. When values are input they are displayed in boldface. You can 

try different combinations of inputs and outputs and view the plots along the way. Some 

variables are indicated to be optional inputs. They are labeled in italics. 

 
The software attempts a solution after each input and displays values for any outputs it 

could find. Default values also appear. For example, when working with compression and 

extension springs, there is a dead coils variable. By default, the value is 0. You can 

replace the default value if necessary. 

 

Adding too many inputs produces an error message. “Inconsistent” means you have at 

least two inputs that contradict each other. Blank one or more inputs and the message 

disappears. You can avoid such error messages by blanking input values you want to 

“backsolve” before entering any new inputs. 
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Here is the round wire compression spring form. 

 

Starting at the top of the form, we see a material selection pull-down menu. To the right 

of that is a button for displaying the properties of the selected material. Buckling 

constraint options are listed to the right of that in another pull-down listing. Various 

buttons and check boxes allow you to specify the coiling direction, tolerance grade, end 

type, and condition. If you have your own fatigue data for the wire to be used in this 

design, check the User-defined SN data box and fill in that form. By default, ASD7 will 

“autoadjust” inactive coils if your spring has closed ends and fewer than four active coils. 
Click to uncheck the box if you would like to turn off this feature. Note that designs 

saved in prior versions of ASD will automatically uncheck that box when they are loaded. 

 

The Input/Output Scenarios are listed next. ASD allows you to input values for any 

variables. Scenarios are provided to assist in choosing which variables to input. When a 

scenario is clicked, several of the fields in the form turn green. If those fields are 

provided inputs, you get a complete solution. Here’s the form with Minimum Weight 

Scenario selected. 
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Most ASD forms include geometry and performance sections. In some of the more 

sophisticated spring types – springs in series or in parallel – these sections may be on 

different tabs in the form to keep the form from getting too long or wide to fit on your 

screen. 

 

In the form below, we stayed in the Power User mode and have input values of the wire 

size and coil diameter. You can see that those values are in boldface. The resulting 

outputs are not. 
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Several of the fields are labeled in italics. Those are optional inputs. Many of them 

obtain default values during the solution process. Tolerances are optional inputs that get 

default values. Others, such as shaft diameter and hole diameter are used for 

comparison only and if the solution conflicts with them, caution messages will be 

displayed. 

 

ASD formats the numbers in each field but if you click in the field you can see the full 

precision of the calculation. Notice the Coil Arbor Diameter field below. 

 

You can double-click in a field to highlight its contents and delete or type over them. If 

you simply click once in a field, you are in “edit mode” and must use the cursor, delete 

and/or backspace keys to edit or remove each character. 

 

Next, we input the free length and the two loads the spring will cycle between. 

 

ASD is able to compute the stresses based on the inputs we’ve made. We see that the 
corrected stress is at 23.6% of the minimum tensile strength (MTS) when the 24 pound 

load is applied. For music wire, this percentage should not exceed 45% (more about this 

when we talk about material properties). 

 

Next, we specify that we will allow the stress to go to 40% of MTS at solid, giving our 

design a little cushion at that extreme condition. This provides enough information for a 

complete solution. We see that ASD computed the coils and pitch and the lengths at 

various loads. 
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ASD plots can be used to give us a better feel for the overall performance of the spring. 

Click the Plots menu on the toolbar to display a plot. Here is a plot of the stress vs. the 

length at load. 
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The plot conveys a lot of information. The blue line shows the relationship between the 

length at load and the stress. The two circles on the blue line correspond with the two 

load points we specified. The two parallel green lines indicate the tolerance bands for the 

stress. Those are based on the load tolerances computed for the spring. The two vertical 

pink lines are at 15% and 85% of the maximum possible deflection. The two dashed 

horizontal lines in the upper portion of the plot indicate the maximum allowable stress 

levels for springs which are not preset (green) and those that are preset (red). 

 

Next, let’s go back to the Plots menu and have a look at the Fatigue Strength Diagram. 

 

The Fatigue Strength Diagram provides a visual estimate of how many times the spring 

might be expected to cycle between the two input loads. The blue diagonal line 

represents virtually infinite life. The sloping red, black, and green lines represent 

expectation of 100,000, 1,000,000, and 10,000,000 cycles. For our spring, we see that 

the design point is located well below the green line, indicating that we should expect 

over 10,000,000 cycles from this spring at normal operating conditions. On the 

input/output form we see that ASD reported the Estimated Cycle Life as “> 1E7” – that 

is engineering notation for “greater than one times ten to the power seven”. 
 

The numbers look good but what about the spring itself? What would it look like? ASD 

provides a 3D visualization tool. We click the Tools menu and select Show 3D. 

 

Click and hold the left mouse button with the pointer in the 3D window and 

you can rotate the image in any direction you like. Click and drag on a corner 

of the window to change the size. 
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ASD also provides a DXF image of the spring. This image is accessed using the Tools 

menu. 

 

The DXF image is automatically included in the reports and can also be exported to a 
DXF file for use with CAD software. The DXF Text Height field can be edited. The default 

value is based on the spring geometry. If you increase the text height value, it will make 

the drawing appear smaller. Decreasing the text height will make the drawing appear 

larger. Click the X box in the upper right corner of the drawing window to close the DXF 

drawing. 

 

ASD cautions us if our design is out of bounds in any way. To test this, we input 1.03 for 

the optional Hole Diameter value. ASD responds with a caution message in the Design 

Status Window. 

 

 

This message is an indication that when the spring is compressed to solid, the expanded 

outer diameter will be greater than the diameter of the hole in which the spring is 
installed. This could impact the performance. Any messages displayed in the Design 

Status Window are automatically included in the reports. 
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Getting Started 

When ASD7 is launched, the main window and New Design form open, as shown below. 

From here you select a spring category by clicking the corresponding spring image. If 

you use profiles, select a profile type and profile, also from drop-down lists. (If there are 
no profiles, or you’re not using them, you can ignore these.) Click the radio buttons in 

the Toolbar for the units you want. Once you’ve made all your selections, click the 

Continue button to open the actual design data window for calculation. 

 

If the New Design form is not displayed, open it by clicking the Toolbar button or by 

selecting the New command in the File menu. 
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Save Design 

A design can be saved with several levels of groupings. This makes it easier to locate the 

design later. 
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Open Design 

ASD7 provides a versatile form for selecting from previously saved and/or archived 

designs. An archived design becomes read only and cannot be modified. 

 

The Open button ............ opens a previously saved design 

The Delete button .......... deletes a previously saved design 

The Archive button ........ a saved design is made read only. This design can no longer 

be edited. The design can be viewed still. 

The Block User button .... prevents a user from being able to open a design. 

 

You may search based on any of the following criteria: 

 
Spring Group Beams, Compression, Compression Series, Compression Parallel, 

Extension, Garter, Spiral, Snap Ring, Torsion, Torsion Bars, Washers. 

Spring Type If a Spring Group is selected, a spring type within that group can also 

be selected. For example, if the Group is Extension, then the Type 

can be cylindrical or conical. 

Customer Designs can be organized by customer. 

Project Designs can be organized by project. 

Part Number The part number is a unique identifier for the design. 

Creation Date You can specify a range of dates that the design was created. 
Archived Parts Only shows designs that have been archived. 

 

When the Search button is clicked, ASD displays a listing of matching designs in the 

Search Results windows. Click to select one, then click Open to load the design. 

Alternatively, you can click Share to allow all other users to have access to the design. 

By default, only users with “Admin” access have access to all users’ designs. Click Delete 

to remove the design from the database. 
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Materials Database 

Viewing Materials 

The button just to the right of the Material field  opens a form that displays the 

properties of the selected material. This form is shown below. Any of the data fields can 

be edited if necessary. 

 

You can choose among three equation types for defining the tensile strength as a 

function of wire diameter. The first equation is a simple equality, which indicates that 
the tensile strength is constant and does not vary with wire diameter. The second 

equation is called a binomial and it requires values for each of the five parameters. The 

third equation is called a polynomial. It also requires values for the five parameters. 

 

Curve-fitting software must be used to estimate the unknown parameters for the 

binomial and polynomial equations, given sample data for tensile strengths at various 

wire diameters. 
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Adding Materials 
By default, ASD works with the list of materials provided with it. You can add materials 

in this list according to your requirements. This is done with the Materials command in 

the Tools menu. On clicking this command, the screen displays a list of materials in the 

database. 

 

When you click the Add, Copy Add or View buttons, the following form appears. 
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If you have clicked the Add button in the Material Details form, all text entry fields in the 

Add Materials form are blank, as shown. Enter material data and click the Save button to 

add the data to the database. 

 

Material Name -- Whatever is entered in the Material Name field will appear in the 

material selection menus throughout the program. 

 

Specification – ASME and other organizations refer to materials by codes as 

exemplified by the default materials in the database. When adding a new material, 

such a code is not required but may be useful. 
 

Standard Size Group – ASD checks designs for standard wire sizes. When adding 

a new material, you can group it so that ASD will assume the same standard wire 

sizes as the other materials in that group. 

 

Minimum Tensile Strength Equation – ASD assumes that the minimum tensile 

strength can be a function of the wire diameter. Three options are provided – 

Binomial, Polynomial, and Constant – and the equations are shown in the form. 

Parameters P0, P1, P2, P3, and P4 are required for the binomial and polynomial 
options while only P0 is required for the constant option. ASD includes a curve-

fitter for estimating the parameter values for the best fitting curve through 

experimental data you provide. You can also use the constant option to force the 

minimum tensile strength to a particular value regardless of the wire diameter. The 

Constant option is the only one available for flat material used in spiral springs and 

washers. 

 

Category – Round and Flat are the two options. Select round for materials used in 

compression, extension, garter, and torsion springs. Select flat for materials used 

in spiral springs, beams, rings, and washers. 
The remaining properties (density, E, G, APB, APT, APTP) are required as they are 

used in designing the various spring types in ASD. 

 

If you have selected Copy Add, text fields fill with data for a selected material. Data can 

be edited and saved under a different name. 

 

If you have selected View, all data fields are locked for editing and the save button is 

not provided. 

 
Check the material specifications form for the associated “APT” and “APTP” percentages. 

 

Design Note: The Life Plots are available only for specific materials: music wire, hard 

drawn (valve), chrome vanadium (valve), chrome silicon (valve), carbon (valve) and 

some of the stainless steels. This plot applies only to carbon steel designs. Consult your 

spring maker for guidance. This plot is for reference only. Actual service life is a factor of 

many variables, including corrosion, cyclic frequency, and temperatures. 
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Changing Variables in Steps 

There is also a feature for changing the value of a particular variable in steps. Two 

buttons and two text entry fields are provided on the Toolbar  for this 

purpose. When you select a particular variable in the input form, its name appears in the 
left text field. Enter the step value in the right text field. By clicking the 

increment/decrement command buttons, you increase or decrease the value. 

 

The second example in the Examples section will give you some practice using this 

feature. 

 

When you increase/decrease the value, the plot automatically refreshes. You view the 

plot with the latest data. This is particularly useful when you want to see the effect of 

the value of a particular variable in the plot. 

Design Status Window 

Messages about the status of the design appear automatically. These messages will also 

appear on the reports. 

 

Working with Profiles 

After you finalize a design, you can save it. If some or all of these variable values will be 

frequently required in other designs, you can save such data sets as profiles and name 

them. 

 

The profile concept permits the reuse of data for a particular set of spring design 

parameters. Thus, instead of starting with a blank input form, you can open a previously 

saved profile and use it as a starting point. 

 

ASD7 is shipped with a system profile for each design category. This profile furnishes 
default values for the category. The system profile cannot be edited or deleted. 

 

You can, however, create as many new user-defined profiles as you wish. For example, 

you might create profiles in each spring category for each customer or design type. You 

can set values for whatever variables you wish—some or all. And the values can, if 

desired, be beyond limits set in the system variable. There will be no conflict. The profile 

system is completely flexible. 
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Adding a New Profile 
To add a profile based on the current design, go to the File menu and select Save as 

Profile. Type a name for the profile and click Save. 

 

To edit a previously saved profile, go to the File menu and select Profiles. Select the 

profile and click Edit. Default minimums and maximums can be set as desired. To 

establish these as firm limits for a particular variable, click its “Firm Limits” checkbox. 

 

If you want validation for minimum and maximum values, set a firm limit with the 

checkbox. If this box is checked, the user of this profile will get an error message during 

calculations if the input data is outside the specified range. 

 

Once the profile values are set, save the profile by clicking the Save button. 

Viewing Reports 

You have the choice of using standard reports, with preset content and format, or you 

can choose only the content you want to be included in your report. 

 

A standard report is generated by selecting Standard Report from the Tools menu or 

by clicking the Standard Report button in the Toolbar. 
 

You can customize a report by including company identifiers, including a logo or 

picture, and selecting plots for inclusion in the report. (Use the View and Add buttons to 

insert company and customer details you’ve previously saved.) Clicking “Preview Report” 

displays the report onscreen; from there it can be printed or exported in RTF or PDF 

formats. 
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Creating a Report 

Click Standard Report in the Tools Menu. Here is a report configuration form for a 

torsion spring. 

 

Click the browse button next to the Custom Report Header Image field if you want to 

browse for an image file (bmp, gif, jpg, or png) to insert at the top of the report. 
Although any image can be inserted there, for best results we suggest that the image 

size be approximately 632 pixels wide and 22 pixels tall. 

 

Contact information is optional. If you click the box, you can select from the customers 

you have stored in the database, along with your company information. 

 

The report can also include plots, material properties, a 3D image, and a fatigue life 

estimate. 
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The DPI field determines the resolution of the plots in the report. DPI must be between 

96 and 200. DPI of 96 makes the details of the plot larger whereas DPI of 200 makes 

the details smaller. See below for a comparison. 

 

DPI 96                              DPI 200 
 

Click Preview Report to view the report and optionally store it as a PDF or RTF file. 

Designed Spring Images in DXF Format 

A DXF drawing of your spring design is included in the Standard Report, as shown below. 
This data can also be saved in the popular DXF format for merging into a CAD drawing. 
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You can use the Show DXF command of the Tools menu or the Show DXF toolbar button 

to view a designed spring in DXF format. 

 

If you are satisfied with the image, store it for use in a CAD program by using the Export 

DXF command. 

 

Use the Regen command in AutoCAD, or its equivalent in other CAD programs, to be 

certain the image is shown correctly. 
 

(Please note that the DXF image provided by ASD7 is not a precise engineering drawing, 

particularly in the end view. If you need a very accurate representation, you might need 

to make appropriate changes in the CAD environment.) 

3D Images 

 

ASD7 provides 3 dimensional images of all spring designs. Images are shown 

in the free position. The image can be rotated and resized. Left-click, hold, 

and drag to rotate the image. Left-click on a corner or edge of the window to 

resize the image. 
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Help Menu 

About 

Clicking About in the Help menu displays the following information about this software. 
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Online Help 

Pressing F1 in any field of the ASD program will open Help to the related page. 

 

Detailed Help is provided with the software in compiled HTML format. This Help 

information explains terms used in the spring design. Also included in the help is a 

collection of Design Notes. These Design Notes summarize some of the new design 
functionality for certain spring types. As updates are made, look for new entries. 

 

The left pane of the help contains 3 tabs. Click on the “Contents” tab to browse through 

topics in a Table of Contents format. Click on the “Index” tab for a glossary style listing 

of tops. Or click on the “Search” tab to search for keywords. 

 

Check for Updates 

Select this help item to see if your ASD7 software is the most current version. 
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Technical Support 

Depending on the kind of problem you are experiencing with ASD7, please contact UTS 

or SMI as follows: 

 
For installation problems, printing, software crashes or other problems with the proper 

working of the software, please contact UTS: 

 Email: support@uts.com 

 Telephone: +1-815-963-2220 

 Fax: +1-815-963-8884 

 

For any other questions such as which formulas are used, selection of spring materials, 

various limits used in the software, other questions regarding how to design springs, etc. 

please contact SMI at: 
 Email: info@smihq.org 

 Telephone: +1-630-495-8588 

 Fax: +1-630-495-8595 
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